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1
Introduction

Import Filter Editor will help you create and edit the filters
for importing references into Reference Manager. The
import filters determines how text files, downloaded from a
database service, are to be read by Reference Manager.
Import Filter Editor creates a single file that you can use
on all databases within a given service.

Technical Support

Technical support is available to registered users Monday
through Friday from 8:00 A.M. to 5:00 P.M. Pacific Time.
You can call, write, fax, or send electronic mal. When
calling RIS Technical Support, please use a phone near to
your computer and have your serial number available.

Before calling, you may want to look at technical support’s
list of frequently asked questions (FAQ’s) on our World
Wide Web (WWW) site.

Research Information Systems
Technical Support
2355 Camino Vida Roble
Carlsbad, CA 92009-1572
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Phone: (760) 483-5526
Fax: (760) 438-5573
E-mail: tech@risinc.com
Web Site: http://www.risinc.com

Chapters in this Book

This book contains the following other nine chapters:

Chapter 2 Examining a Text File—provides general
information on viewing the text file containing the
references to be imported. This is a first step before
getting involved with Import Filter Editor.

Chapter 3 Getting Started with Import Filter Editor—
covers how to start the program, and an introduction to the
look and feel of the main screens.

Chapter 4 Working with the Basics—covers some basic
procedures you will be using as you create and modify
import filters.

Chapter 5 Working with an Import Filter—provides
step-by-step instructions for creating an import filter.
Describes how to add or change databases, reference
types, or tags.

Chapter 6 Testing an Import Filter—covers the process
of testing your import filters using Reference Manager.
This helps to ensure the import filter is going to work as
intended.

Chapter 7 Printing Import Filter Information— covers
how to print and view information in Import Filter Editor.
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You can print only from the Database tab. All information
on the selected database prints.

Chapter 8 Troubleshooting— covers how to solve some
of the common problems you might encounter.

Index
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2
Examining a Text File

Before working with Import Filter Editor, let’s look at a text
file and get familiar with components to which you will
need to refer. As you create import filters using the Import
Filter Editor, you specify tags, delimiters, and so forth—
based on what the text file looks like.

You need to download references in a tagged format to a
text file from the database service. You should also
download all the fields in the reference.

When you view the text file, be careful to note the case
(upper case or lower case) of the text. As you create tags
in a later chapter, make sure to type text in the same case
as it appears in the text file.

In this chapter, we will look at:

♦ Viewing the Text File

♦ Identifying Reference Formats

♦ Identifying Database Identifiers

♦ Identifying References Type Identifiers

♦ Identifying Tag Formats

♦ Identifying Replace Text
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♦ Identifying Text Styles

 Specifically, this chapter covers viewing the text file and
locating the references and database identifiers. Then, we
will locate the fields in each reference and the tags that
identify them. Later, we will be specifying these tags and
identifiers as we create the import filter. We will also
discuss Replace Text—that is text within your downloaded
file that you do not want imported into Reference
Manager.

 Viewing the Text File

 You can view a text file within a word processor. Or, you
can print several pages from a text file and work from the
paper copy.
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 As you look at the text file, notice that it is divided into
logical groupings of information. The text file contains a
series of references. Each reference is made up of one or
more fields. You need to determine how these groupings
are set up in the text file, so that you can enter this
information into Import Filter Editor. Normally all the
references in a text file are from one database. However,
a text file might also contain references from more than
one database.

 As you work in Import Filter Editor, you will be switching
back and forth between viewing the text file and viewing
Import Filter Editor windows and dialog boxes.

Identifying Reference Formats

 To identify a reference in your text file, look at the file for
an indication of what separates one reference from the
next. In most instances, it is a blank line. But, you can also
use distinct text or a tag that appears either at the
beginning or end of the reference.

 In the sample, there is a dashed line between the
references. Additionally, the references are separated by
the record number (Record 1 of 2) that clearly states
where the reference starts. This information is specified in
the Reference and Tag Format tab in the Service window.

Identifying Database Identifiers

 The first type of identifier we need to find is the database
identifier. This is the text in the reference that identifies
the database from which this reference came. In most
instances, this will be the name of the database.
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 Notice in the sample above, the first two references’
database identifiers are “MEDLINE,” while the third
reference’s database is identified as “Current Contents.”
Identifiers must be specified exactly as they appear in the
file and must be unique to references from that database.
This information is specified in the Database tab in the
Service window.

Identifying Reference Type Identifiers

 A reference type identifier is the text within a reference
that identifies the type of reference. It must be specified
exactly as it appears in the file and must be unique to
references of that type. In most instances, one of the
tagged fields in the reference contains the reference type
information which you can use as the identifier.

 In the sample, the PT tag contains the identifier
“JOURNAL-ARTICLE”. This information is specified in the
Reference Type tab in the Database window.

Identifying Tag Format

 Tags mark the beginning of each field. The tag format
consists of the characters that are common in all the tags.
More specifically, you need to identify each character at
each position in the tag and determine if they are the
same in all the tags. If the character is not the same, then
you need to determine if the characters at that position are
in one of the predefined character sets.

 In the above sample, all the tags occur at the beginning of
the line and consist of either two or four uppercase letters
followed by a colon and spaces. To identify what these
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tags have in common, you notice that all tags are at the
beginning of the line and are followed by at least two
upper case letters. Therefore the tag format is “¶\u\u”. ¶
represents a new line or end of a line and \u represents
the uppercase letters character set. This information is
specified in the Reference and Tag Format tab in the
Service window.

 Tag formats can include special characters, character
sets, and literal characters such as spaces, dashes,
colons, and text characters. You must identify these
correctly in order for any information to be transferred into
Reference Manager.

Identifying Replace Text

 Replace text is any text in a field that you do not want
imported or that you want replaced with other text before
importing into Reference Manager—such as those
sometimes found at the end of a line or field. Once you
determine the undesired text, you can specify this in the
Replace Text tab of the Edit Tag dialog for the field where
this text appears. Then Reference Manager, as it imports
the text file, performs the Replace text in the order
specified.

Identifying Text Styles

 Some database services download style attributes such as
bold, italic, and underline in the text file. They appear as
symbolic characters beginning or surrounding the styled
text, e.g. “\bBolded word\b”.
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 As you import text, you can control whether or not these
style attributes are retained as the text comes into the
database. If you want to retain the style attributes, specify
the surrounding symbolic characters in the Text Styles tab
in the Service window. If you do not want to import a word
with a text style, you can remove the symbolic characters
by specifying them as replace text.
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 3
Getting Started with Import Filter Editor

 This chapter is designed to help you get started using
Import Filter Editor. Use this chapter to learn how to
launch Import Filter Editor and to gain an understanding of
the user interface.

 This chapter covers:

♦ Launching Import Filter Editor

♦ Understanding the Menus

♦ Understanding the Windows and Dialog Boxes

Launching Import Filter Editor

There are four ways to access Import Filter Editor—from
Windows or from Reference Manager. These methods
are:

To launch Import Filter Editor:

• From Windows, go to the Start menu, select
Programs, then Reference Manager, and then
Import Filter Editor.

• From Reference Manager for Windows, from the
Tools menu, select Import Filter Editor.
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• From Reference Manager for Windows, click the
button marked IFE on the Toolbar.

• From Reference Manager’s Import Text File dialog,
click the Edit Filter button after specifying a filter,
then click on the Advanced button.

Understanding the Menus

There are five menus in the Import Filter Editor program,
accessible from the menu bar at the top of the screen.
Three are visible initially and two additional ones are
visible when you open an import filter. These menus
provide access to Import Filter Editor commands and
functions.

The main function of each is described below.

• The File menu provides options that let you work with
an import filter file. These options include creating,
opening, closing, or saving import filters. You can also
print the current database’s specifications from this
menu. The bottom portion of the menu keeps track of
the last four files opened.

• The Edit menu provides options that allow you to cut,
copy, and paste text.

• The View menu lets you view or hide the toolbar and
status bar.

• The Window menu lets you arrange windows for
viewing on you desktop and lists the currently open
windows.

• The Help menu provides access to online help and
information about the Import Filter Editor.
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Understanding Windows and Dialog
Boxes

Two windows provide access to information in Import
Filter Editor. These windows have a similar look and feel,
but are used to enter different levels of information. In
addition, the Edit Tag dialog box, used for specifying tag
information, acts as a third level in which to add
information.

The Service Window

The top-level window, the Service window, shows
information at the highest level—that is information about
the database service in general.

Tabs in the Service Window

There are five tabs in the Service window. They are:
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The Databases tab, shown above, shows all defined
databases for this database service. Each has a unique
identifier and descriptive name.

The Common Tags tab contains tags that are common to
all databases and reference types.

The Reference and Tag Format tab is used to define the
formats of references and tags for this database service.
The information in this tab determines how Reference
Manager parses a reference and a tag in the downloaded
text file.

The Text Styles tab lets you define the text style
attributes, if any, in your text file. Any text in the text file
surrounded with the specified start and stop sequences will
import into Reference Manager with that style.

The Properties tab contains general information about the
database service and the import filter file. The Service’s
name is listed here.

The Database Window

When you click the Edit button from within the Databases
tab, the Database window appears for the database where
your cursor was. The Database window, accessed from
the Service window, provides the second level of
information in Import Filter Editor. It displays Reference
Types and their specific tags for a specific database.
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Notice that the title bar shows the name of the database.

You can go back to the Databases tab in the Service
window at anytime by clicking on Return to Databases.

Tabs in the Database Window

This window shows the following tabs:

The Reference Types tab lets you specify the reference
types that you want imported from the database.

As you add a reference type (e.g., Journal), a tab for the
reference type’s tag appears. This new tab lets you specify
the tags imported for this reference type.

Here, more tabs are shown. There is one tags tab for each
different reference type defined.
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When there are more tabs than will fit across the screen,
you can scroll to locate the other tabs.

The Edit Tag Dialog Box

The Edit Tag dialog box lets you define field tag specific
information. You can access the Edit Tag dialog box from
two windows:

• Under the Common Tags tab of the Service window,
insert the cursor on the line of the tag to edit and click
the Edit button. This dialog box pops up automatically
when you create a new tag.

• Under the tags tabs of a specific reference type of the
Database window, insert the cursor on the line of the
tag to edit and click the Edit button. This dialog box
pops up automatically when you create a new tag.

The additional
tabs
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The options in this dialog box vary depending on the
Destination field and Parse method selected. The Parsing
Options that appear, in particular, are dependent on the
Parse method.
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4
Working with the Basics

Once you have launched the program and gotten familiar
with the interface, you are ready to begin working with
some of the basic functions in Import Filter Editor.

These basic functions include:

♦ Using Special Characters and Character Sets

♦ Saving Files in Import Filter Editor

♦ Working with Tags

Using Special Characters and
Character Sets

As you specify identifiers and formats in Import Filter
Editor, you may want to enter special characters and
character sets. Special characters are mostly hidden
characters, such as an end of line or a tab character. If
you are using a word processor to look at the text file, you
can view these special characters by showing hidden text
in your word processor.

A character set is a group of characters that you can use
when you cannot specify a specific character in a format
or identifier. Import Filter Editor comes with predefined
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character sets, or you can create your own custom
character sets. For example, a tag format that consists of
an end of line character followed by two uppercase letters
looks like this “¶\u\u”. ¶ is a special character and \u is the
predefined character set containing all uppercase letters.

Fields that allow special characters or character sets have
an arrow button to the right of them. You can enter special
characters and character sets by clicking this arrow button
and selecting an item from the pop-up menu or typing
them in the field. Depending on the field, you see a
different pop-up menu.

To enter a special character or predefined character
set:

1.  Place the cursor in a field, such as the Separator
format, where you need to enter a special character or
character set.

2. Click the arrow, and the special character menu
appears.

Special characters
or character sets
can be used in this
field.
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Use the Custom Character Set if you want to manually
type the character set, rather than choose a
predefined one.

The other characters are as follows:

Any uppercase letter: A-Z

Any lowercase letter: a-z

Any number: 0-9

Any letter: a-z and A-Z

Any letter or number: a-z, A-Z, and 0-9

Any letter or space: a-z, A-Z, and space character

Any letter, number, a-z, A-Z. 0-9, and space
or space: character

Any character: any and all characters

3.  Select an item from the menu by clicking it.

The symbol for the special character or character set
appears in the field.

4.  Repeat the process to enter additional special
characters or character sets.

These are the Special
Characters

These are Character Sets
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To build a custom character set:

1.  Select Custom Character Set from the special
character drop down menu.

2.  Type all the characters you want to use in this custom
character set. Or click the arrow to select from the
special character menu.

3.  When you are done, click OK.

The custom character set appears in the field.

Saving Files in Import Filter Editor

This section describes how to save import filters. It is
recommended you save the file intermittently as you work
in it.

Import filters created by RIS cannot be modified. For
these filters, the Save command is disabled on the File
menu and the status bar displays an RIS indicator.

When saving an import filter, the default file extension is
CAP. This extension is necessary for Reference Manager
to recognize the file as an import filter. It is recommended
that you save filters in the Import folder located in your
Reference Manager program folder. Use the Save
command from the File menu to save new or modified
import filters.
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Using the Save As Feature

You can make a copy of an import filter by using the Save
As command, making changes to this copied file, while
retaining the original. You can create as many altered
copies of these files as you need.

The Save As feature is useful for copying RIS created
filters so you can modify them.

Working with Tags

As you work in Import Filter Editor, you need to view the
text file and determine which tags to import and the type.
This section provides some hints on how to make the
selection.

Import Filter Editor classifies tags into three types:

♦ Common Tags

♦ Reference Type Specific Tags

♦ Source Tags

Understanding Common Tags

Common tags are those tags that are the same for more
than one database or reference type within a database
service. Common tags are the easiest to use as you
define them once. They can be used in all reference types
defined. If you do not want to import a common tag for a
specific reference type, you can exclude it.
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Understanding Reference Type Specific Tags

Reference Type specific tags are tags that are parsed
differently for more than one reference type and must be
defined individually for each reference type. You define
reference type specific tags in the Database window in its
reference type tags tab.

You can use both reference type specific and common
tags to define all tags to be imported for a reference type.
To have Reference Manager import the tag, select the
checkbox in the Incl column. To have Reference Manager
not import the tag, clear the checkbox.

When Reference Manager imports a tag, it searches the
reference type specific tags first. Then, if there is no
match, it searches the common tags. If there is still no
match, then the tag is not imported.

You can check
or uncheck here
to indicate if the
tag is used
during import

You can do the
same with these
common tags.
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Understanding Source Tags

Source tags are used when there is more than one piece
of data in a tagged field that imports to more than one
Reference Manager field. You use a Source tag to indicate
how and where each piece of data should be parsed by
Reference Manager during the import.

Normally a tagged field imports into one Reference
Manager field. For example, the TI tag imports into
Reference Manager’s Title field. However, some tagged
fields import into more than one Reference Manager field.
As the following example shows, the SO tag for this
journal reference imports into the Periodical, Volume,
Issue, Pages, and Publication year because it contains
multiple types of information.

SO: Journal of Allergy and Clinical Immunology. 92(6):802-811, 1993

Dec.

You can create Source tags by setting the Destination
Field to <Source> in either the common or reference type
specific tags tab. Each piece of data in the source tag is
specified in the Source Subfield tab in the Edit Tag dialog
box.

To make the Source Subfields tab visible, do the
following:

1.  In either the Common or reference type specific tags
tab, put your cursor on the line of the tag that you want
to be a source tag.

2.  Click the Edit button.

3.  Select the Properties tab.
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4.  In the Destination field, select <Source>.

A confirmation message appears.

5.  Click Yes.

6.  Click the Source Subfields tab to view this window.

Mapping Tags to Reference Manager Fields

Mapping is the process of matching the field of one
reference type to the corresponding field in another
reference type. Since field names are customizable in
Reference Manager (except for the Generic reference
type) each field can be named differently in each
reference type.

Import Filter Editor uses the generic reference type’s field
names in the Destination field’s drop-down list since it is
not customizable. So, when you select the destination field

The Source
Subfields tab

Indicates the
delimiter before the
subfield data

Indicates the
delimiter after the
subfield data
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for the tag in Import Filter Editor, make sure it maps
correctly to the field for the reference type in your
database.

Field numbers next to the field name also help you when
you are trying to figure out what fields in your database
map to what fields in the generic reference type. Another
helpful tool is the Field and Type Editor in Reference
Manager.
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5
Working with an Import Filter

Included with Reference Manager are some common
import filters for the more popular database services.
These will help you get started. You may want to create
import filters for other database services from which you
import data into Reference Manager.

This chapter covers creating new definitions and opening
and editing existing definitions. It includes these sections:

♦ Creating a New Import Filter

♦ Working with an Import Filter

♦ Working with a Database

♦ Editing Tags or Subfields

 Creating a New Import Filter

 For each database service you subscribe to, you create a
separate import filter in Import Filter Editor. If there are
distinguishable differences in the format of the references
or tags between databases within a service, you may want
to create a separate filter per database. However, if the
formats are identical, then within an import filter you can
create as many databases as you need.
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 There are two ways to create an import filter:

♦ Using the New Import Filter Wizard

♦ Manually

The New Import Filter Wizard takes you through some
initial steps for setting up a definition. However, there are
other options not covered in the wizard that must be
specified before the filter will work, such as creating
databases, reference types, and tags. You might want to
review the sections in Working with an Import Filter on
page 34, for additional information.

To create a new import filter using the Wizard:

1.  From the File menu, select New.

You are asked if you want to use the New Import Filter
Wizard.

2.  Click Yes.

If you select No, you can create an import filter
manually. See the following section for instructions.
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3. Specify the file name and folder of the import filter, or
browse to specify the file name and folder. Then click
Next.

It is recommended you use a descriptive file name
that pertains to the database service. Save the file in
the Import folder of your Reference Manager program
folder. End the file name with the extension .CAP.

4. Type the name of the service and an optional
description, and click Next.
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5. Select Yes or No, and click Next.

If the text file does not use ANSI characters, for
example if it came from a DOS-based system, click
No. Otherwise, click Yes.

The ANSI character set contains diacritical characters
that are mostly used in foreign languages. Examples
of diacritical characters are ñ or ü.

6. View your text file to determine the distinct separator
between references. Then select the separator that
divides one reference from the next.

7. Do one of the following:

• If you chose Blank line(s), in the Number of
blank lines field, type the number of blank lines
that appear between references.

• If you chose Reference marker, which is any text
marking either the beginning or end of a reference
or Tag, do the following:

a. In the Tag/Reference marker field, enter the
specific reference marker or tag that
separates the references.
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b. In the Where does this separator appear in
the reference section, indicate if the marker
or tag appears at the start or end of each
reference.

• When you are done, click Next.

8. Select Yes or No to indicate if the fields in the
references are preceded with tags.

If the references are not in a tagged format, such as a
comma delimited format, select No. Otherwise, select
Yes.

9. If you selected Yes above, in the Tag format field,
enter in the tag format.

For instructions on how to do this, see Identifying Tag
Format on page 14.

10.  Then, click Finish.

The new import filter is created. The Databases tab
appears on your screen. You will still need to define at
least one database, a reference type, and tags in
order for this filter to work properly. To define a
database, go to Defining Databases on page 40.
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To create an import filter manually:

1.  From the File menu, select New.

You are asked if you want to use the New Import Filter
Wizard.

2. Click No.

See, Working with an Import Filter, below, for a
complete description of how to fill in information in the
tabs.

Working with an Import Filter

When working with an import filter, you can:

♦ Open an Existing Import Filter

♦ Define Databases



40 Import Filter Editor User’s Guide

♦ Define Common Tags

♦ Change Reference and Tag Formats

♦ Change the Text Styles

♦ Change Properties

Opening an Existing Import Filter

This section describes how to open an existing import
filter.

Opening an existing import filter:

1.  From the File menu, select Open.

2.  Locate the import filter to open and click Open.

To make changes to a RIS import filter (one created by
RIS), you need to make a copy of the import filter and
then make changes to the copy. You do this using the
Save As command. This renames the file—as the RIS
created filters cannot be modified. Therefore, you always
retain the original version of the RIS import filters. You
can create as many altered copies of these files as you
need. These are located in the Import folder.

Defining Databases

You will need to define a database for each database in
the service that you want to import into Reference
Manager. You can also edit and delete database
information for databases in the service.
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For each filter in Import Filter Editor, there is one database
that is the default. If Reference Manager cannot identify
the database from which the reference came, then the
default database is used.

To work with information in the Database tab:

To access this tab: From the Service window, click on
the Databases tab.

Def column—click here to make this database the
default.

The default database is the database reference manager
will use if it can’t find any of the defined database
identifiers.

Identifier column—enter the identifier for this database.
The identifier is the text in the reference that identifies the
database from which this reference came. In most
instances, this will be the name of the database.
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The Identifier consists of text characters, special
characters, and character sets that Reference Manager
uses to identify the database or reference type of a
reference in the text file. To enter special characters or
character sets, click on the arrow button and use the
special character menu.

The Identifier must be in the reference and must be
unique to the reference. Enter the Identifier exactly as it
appears in the text file (case sensitive).

Description column—type the name for the database.

Edit button–put your cursor on the database you want to
edit and click this button. The database window is opened
allowing you to add or modify reference types and tags
imported for this database.

New button—click here to add a blank line from which
you can add a new database.

Delete button–put your cursor on the database line you
want to delete and click this button.

Set as default button–put your cursor on the database
line you want to be the default database and click this
button. The default database is the database Reference
Manager will use if it can’t find any of the defined
database identifiers.

Defining Common Tags

For information on defining common tags, see Working
with Common Tags, on page 49.
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Changing Reference and Tag Formats

The options from which you can select in the Reference
and Tag Format tab include:

Separator type–this identifies what separates references
in the text file. The options include:

• Begin reference marker–text that is consistently at the
beginning of a reference that is not in a tagged field.

• End reference marker–text that is consistently at the
end of a reference that is not in a tagged field.

• Blank line–one or more blank lines are between each
reference in the text file.

• First tag–a tag that is always the first tag of each
reference in the text file.

• Last tag–a tag that is always the last tag of each
reference in the text file.

Separator format–this is only enabled when separator
type is not Blank Line. Enter either the format of the
reference marker or the tag that is the separator between
references.

Arrow button–pops up the insert special character menu
for inserting into the Separator format field.
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Browse button–this is only enabled when separator type
is First Tag or Last Tag. This displays a list of defined tags
to choose from.

Number of blank lines–only available when separator
type is Blank Line. This specifies how many blank lines
are between references in the text file.

 Tag format–can include special characters, character
sets, and literal characters such as spaces, dashes,
colons, and text characters. You must identify these
correctly in order for any information to be transferred into
Reference Manager.

Changing Text Styles

If the original text file contains text style markers, such as
“\b” for bold, you can retain these attributes in the
Reference Manager database by defining them in the Text
Styles tab.

If the original text field does not contain text style
attributes, then you don’t need to set these text options.

To change text styles:

1.  Click the Text Styles tab.
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2. If the text file contains ANSI characters, select the
Contains ANSI characters check box.

 When this option is selected, ANSI characters are
imported correctly from the text file. The ANSI
character set contains diacritical characters that are
mostly used in foreign languages. Examples of
diacritical characters are ñ or ü. Refer to the Windows
Character Map for a list of ANSI characters and their
keyboard equivalents.

3. In the text file, determine the text style format (such
as \u for underline) that begins or surrounds the styled
text. In the Start sequence column, type the
characters before the styled text.

 Hint: You can also use the arrow to the right to enter a
special character. This also applies to the Stop
Sequence field.

4. In the Stop sequence field, type the characters after
the styled text if any.
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If there is no stop sequence, then the style is applied
to the whole word following the start sequence.

5. Enter all other text styles, if any, using the same
method.

6. When you are done, select Save from the File menu.

Changing the Properties

From the Properties tab, you can change the Service
name and Description.

To change the Properties information:

1.  Select the Properties tab.

2. In the Service name and Description fields, make
any changes as desired.
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3. When you are done, from the File menu, select Save.

Working with a Database

Once you have created or opened an import filter, you are
ready to work with the databases in it. You can add or
modify the database’s reference types and tags, and you
can specify what data in the tagged field is imported into
Reference Manager.

Defining Reference Types

For each database defined, you need to add reference
types. You add them for each different type of reference
from that database that you want to import into your
Reference Manager database. Reference types include
books and articles.

You can also delete defined reference types, or you can
set a particular reference type as the default.

For each database in Import Filter Editor, there is one
reference type that is the default. Any unidentified
reference types from the database in the text file are
imported as the default reference type.

To work with information in the Reference Types tab:

To access this tab: In the Databases tab, put your cursor
on the line of the database that you want to edit and click
Edit.
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Def column—click here to make this reference type the
default.

Identifier column—specify a unique identifier.

A reference identifier is the text within a reference to
identify the type of reference. It must be unique to
references of that type. In most instances, one of the
tagged fields contains the reference type information.

The Identifier consists of text characters, special
characters, and character sets that Reference Manager
uses to identify the reference type. To enter special
characters or character sets, click on the arrow button and
use the special character menu. Enter the Identifier
exactly as it appears in the text file (case sensitive).

Reference Type column—select a type from the drop-
down list. The drop down list displays the reference type
labels from a standard Reference Manager database. If
you have customized the reference type labels in your
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Reference Manager database, you have to use Reference
Manager’s Field and Type Editor (under the Tools menu in
Reference Manager) to see what standard reference type
label to specify.

Return to Databases button–click here to return to the
Databases tab in the Services window.

New button—use this to add a reference type if one
hasn’t been already added.

Delete button—put your cursor on the reference type line
you want to delete and click this button.

Set as default button—put your cursor on the reference
type you want to be the default and click this button.

The default reference type is used by Reference Manager
when it can’t find any of the reference type identifiers for
this database.

Preview checkbox—check here to display a preview of
the tag, based on the settings chosen in the dialog.

Defining Tags

There are three types of tags you can define in the
database: common tags, specific reference type tags, and
source tags. These tags are explained in chapter 4. This
section shows you how to add and define them as well as
other functions you can perform.

If many of the tags are the same in more than one
database or reference type, it may be easier to define
these tags in the Common tags tab. Then, you can make
any specialized tags in the reference type specific tags
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tabs. You may want to use this approach to save work and
time.

Working with Common Tags

Each reference type contains several tags. The tags
indicate the fields, such a Title, Author, and Date. So, for a
reference type such as Journal, you might have ten or
more tags.

Common tags are those tags that more than one reference
type has in common. Title, Author, Keywords and Date are
examples of tags that are the same in most reference
types in a database service. You define all the common
tags that you want to use for all reference types in the
Common Tags tab. Then, they are automatically included
in every reference type defined. You can also exclude a
common tag in the reference type if you so desire.

To work with information in the Common Tags tab:

To access this tab: From the Services window, click on
the Common Tags tab.
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Tag column—type a tag label. Type the tab label exactly
as it appears in the text file (case sensitive). Click the
arrow to insert special characters using the special
character menu, if needed.

Destination Field column—specify the Reference
Manager field into which this tag will import.

For more information, see Mapping Tags to Reference
Manager Fields on page 32.

Edit button–brings up the edit tag dialog box for the
selected tag.

New button—use this to add a tag.

Delete button–deletes the selected tag from the list.
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Working with Reference Type Specific Tags

You can define specific tags for a given reference type.

To access reference type specific tags:

1.  In the Databases tab, insert the cursor in the line of
the database which you are defining reference types.

2.  Click Edit.

The Database window appears with the Reference
Types tab showing the Reference Types listed for this
database. Notice for each reference type you have
created, there is also a corresponding reference type
specific tags tab.

3.  Select the Reference Manager tags tab for the
reference type for which you want to define tags.

For example, to define tags for the Journal Reference
Type, you would select the Journal Tags tab.
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Notice the Common tags are shown at the bottom of the
window. They are automatically included in each reference
type. You can exclude them from a reference type by
clearing the check box in the Incl column.

To define reference type specific tags:

To access reference type specific tags, see the preceding
procedure.

Incl column—clear the checkbox for those tags you do
not want to import (whether Reference type specific tags
or Common tags).

Tag column—type a tag label. Type the tab label exactly
as it appears in the text file (case sensitive). Click the
arrow to insert special characters using the special
character menu, if needed.
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Destination Field column—specify the Reference
Manager field into which this tag will import. For more
information, see Mapping Tags to Reference Manager
Fields on page 32.

Return to Database button—click this button to return to
the Databases tab in the Service window.

Edit button—click this button to edit the selected tag.

New button—use this to add a new tag. A blank line
appears in the Tag column, letting you add the new tag.
You can use the drop down arrow to access special
characters. Type the tag label exactly as it appears in the
text file (case sensitive).

Delete button—click this button to delete the tag from the
list.

Preview checkbox—check here to display a preview of
the tag, based on the settings chosen in the dialog.

Working with Source Tags

Source tags are used where there is more than one piece
of information in a tagged field that imports into more than
one Reference Manager field. Most fields include just one
piece of information—such as a title. Source tags include
multiple pieces of information—such as a journal name,
date, and page numbers.

A source tag can be defined as a common tag. In most
cases, however, the data in a source tag is specific to a
reference type. To define a source tag, follow the steps
above for defining either a common tag or a reference
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type specific tag and then set the Destination field to
<Source>.

Editing Tags or Subfields

Defining Properties

In this tab you will instruct Reference Manager in how to
parse the data in the tag field before importing.

To specify options in the Edit Tag or Edit Subfield
dialog:

To access this tab: You can do so either from the
Common Tags tab or a reference type specific tags tag.
Put your cursor on the tag or subfield you want to edit and
click Edit.
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Tag field—is already filled in. You can edit this field.

Destination field—is already filled in. You can edit this
field.

Parse method field—contains the most appropriate
choice for the Destination Field you chose. You can
change the parse method, but it is recommended you use
the default option.

Ends with before replace field—lets you specify
characters that determine the end delimiter of the data to
import.

Ends with after replace field—lets you specify
characters that determine the end delimiter of the data to
import.

The Ends with before parsing is the end delimiter before
doing the Replace text. The Ends with after replace is the
end delimiter after doing the Replace text.

The End with after replace is the same as the End
Delimiter of the subfield if you are in an Edit Subfield
dialog box. If you do not specify either end delimiters, all
the data in the field is imported.

Remove tag/start delimiter box—if you do not want the
tags/start delimiter (such as AU for author) to be imported
into Reference Manager with the data, check this box.

Parsing Options box—on the right side of the dialog box,
fill in the fields. These fields vary depending on the Parse
method.

For detailed information, see Parsing Methods, below.
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Parsing Methods

The parse method and options effect how the data is
imported in Reference Manager. The following parsing
methods and their associated options are described below:

Normal

Case conversion Specify how to change the case of
data if needed:

Other Parsing:

• Replaces any carriage return-line feeds and removes
any extra spaces in the data.

Multi key

Keys separated by Delimiter between keywords, if there
is more than one.

Space character Delimiter between words in a
keyword. This delimiter is converted
to a space when imported.

Case conversion Specify how to change the case of
data if needed.

Other Parsing:

• Replaces any carriage-return-line feeds and removes
any extra spaces in the data.

Author

Authors separated by Delimiter between authors, if there is
more than one.

Case conversion Specify how to change the case of
data if needed.

Other Parsing:
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• Reference Manager uses smart parsing to parse the
last, first, middle, and title name parts from the author
name. If “=” precedes the author name, smart parsing
is suppressed and the name imports as is. The “=” is
used mainly for importing corporate author names.

Periodical

Case conversion Specify how to change the case of
data if needed.

Synonym type Specify the synonym type of the
periodical: Full, Abbreviated, User 1,
or User 2.

Period character Delimiter after abbreviated words.
This delimiter is converted to a period
when imported.

Space character Delimiter after non-abbreviated words.
This delimiter is converted to space
when imported.

Other Parsing:

• Replaces any carriage return-line feeds and removes
any extra spaces.

• If the Period character and the Space character are
the same, each word in the data is looked up in
Periodical Term Dictionary to determine if it is
abbreviated or not. If the word is not in the dictionary,
then it is an abbreviation and is followed by a period.
Otherwise, it is not an abbreviation and is followed by
a space.

• If the Period character and the Space character are
different, the words preceding the Space character are
added to the Periodical Term Dictionary.

Reprint
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Reprint data Specify whether the data contains
the reprint status, reprint request
date, or both.

“Not in File” ID Identifier if status is Not in File.

“In File” ID Identifier if the status is In File.

“On Request” ID Identifier if the status is On
Request.

Request date begins with Delimiter before the request date.

Request date ends with Delimiter after the request date.

Other Parsing:

• Reference Manager uses smart parsing to parse the
year, month, day, and other parts of the request date.

Source

A Source Subfield appears where you can specify the
subfields.

See the section, Defining Source Subfields, on page 54.

Pages

Other Parsing:

• Reference Manager uses smart parsing to parse the
start and end page.

Date

Other Parsing:

• Reference Manager uses smart parsing to parse the
year, month, day, and other parts of the date.

In Reference Manager, smart parsing requires that the
captoken.dat file be in your program folder when you
perform the import.
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Case Conversion

The Case Conversion drop-down list lets you change the
case used in the tagged field before importing it into
Reference Manager. You have these choices:

No conversion–leaves the case of the data as is.

Upper case–converts all letters to uppercase.

Lower case–converts all letters to lower case.

Sentence case–if the data is not already in mixed case,
this option uppercases the first letter of each sentence.
Leave all other letters in lower case.

Title case–if the data is not already in mixed case, this
option upper cases the first letter of each word. Leaves all
other letters in lower case.

Author case–if the name is not already in mixed case,
this option uppercases the first letter of each name and
initials. Leaves all other letters in lower case.

When using Sentence case, Title case, and Author case
conversions, words that are in the Reference Manager’s
Casing Term dictionary are imported using the term from
the dictionary.

Defining Replace Text

One of the functions you can use in Import Filter Editor is
to delete or replace specific text with different text in a
tagged field. For example, if there are tab characters in
the data that you do no want to import, you can replace
them with a space.
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To specify text to delete or replace in a tag:

1.  Select the tag containing the text to delete or replace
by clicking anywhere on the tag’s line.

You must be in either the Common Tags tab (Service
window) or the reference type specific tags tab
(Database window).

2.  Click Edit to open the Edit Tag dialog box.

3.  Click on the Replace Text tab.

 

4.  Click New.

 

 A blank row appears for you to add text.
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5.  Do one of the following:

• To find a certain text string, type the text in the
Find From column. Leave the Find To column
blank.

• To find a range of text, in the Find From column
type the first character(s) of the text. Then in the
Find To column, type the last character(s) of the
text.

 For example, if you wanted to replace text within
parentheses, you can enter (“ in Find From
and”) in Find To.

6.  In the Replace With column, type the replacement
text.

 If you are using this function to remove text, and not
to replace text, leave the Replace With field blank.

7.  In the Find direction box, select the direction in which
you want Reference Manager to perform the search.

 If you chose Backward, for example, it searches the
tagged field from the end of the field.

8.  In the Number to replace box, select how many times
you want this replacement to occur.

 If you select All occurrences, then all instances of this
text are replaced or deleted. If you just want to make a
limited number of replacements, click the radio button
next to Number, and type the number of replacements
to make.

9.  In the If “Find To” not found/empty box, choose
what you want Reference Manager to do if the text in
the Find to column is not found or if there is no text in
this column.
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 If the Find To field contains text that is not found,
Reference Manager can either skip the text
replacement, or it can replace all text from the Find
From text to the end of the field.

 If the Find To field contains no text, it can replace text
in the Find From, or it can replace the text from the
Find From to the end of the field.

10.  Add any additional lines by clicking New and
repeating the process.

11.  When you are done, click Apply or OK.

Defining Source Subfields

When you select <Source> as the Destination field of a
tag, you need to complete the Source Subfields tab in the
tag’s Edit Tag dialog box. You need to define for
Reference Manager the Start and End Delimiters for each
subfield.

To define Start and End Delimiters for subfields, you must
find distinct characters that consistently surround the
subfield data, such as a comma or semi-colon.

To access Source Subfields:

1.  Start from either the Common Tags tab in the Service
window or a reference type specific tags tab in the
Database window.

2.  Place the cursor on the line of the source tag (the tag
where the Destination field is set to <Source>) and
click Edit.

3.  Click on the Source Subfields tab.
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To define Source Subfields:

To access the Source Subfields tab, use the preceding
procedure.

Start Delimiter column—type the character(s) for the
starting delimiter for the subfield. If the start delimiter is
not found, then this subfield is not imported. Then
Reference Manager will look for the next subfield’s start
delimiter.

Destination field column—select the corresponding
Reference Manager field into which this tag imports. The
Edit Tag or Edit Subfield dialog box may appear if this is
the first time the Destination field is specified.

If this dialog box appears, fill it out as needed. For more
information, see Editing Tags or Subfields on page 55.
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End Delimiter column—type the ending delimiter for the
subfield.

Subfields are listed in the order that they appear
checkbox—check here if the subfields are listed in the
order that they appear in the source tag. If they are not
listed in this order, then clear this check box.

The same order means that Reference Manager searches
for the start delimiter of a subfield starting from the
beginning of the previous subfield.

If they are not in the same order, then Reference Manager
searches for the start delimiter of each subfield from the
beginning of the tagged field.

Edit button—use this button to edit the selected subfield.
This function brings up the Edit Subfields dialog box for
the subfield.

New button—use this button to add a new subfield.

Delete button—use this button to delete the selected
subfield from the list.

Preview section—displays a preview of the subfield,
based on the settings chosen in the dialog.
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6
Testing an Import Filter

After you are finished creating or working with an import
filter, you need to test it. Testing the import filter ensures
that the databases, tags, and references you have added
and defined are working as you intended them to.

Test an import filter using Reference Manager by actually
importing a text file downloaded from the database service
into a new database

IMPORTANT: This procedure is done from Reference
Manager, not Import Filter Editor.

To test an import filter:

1.  Open Reference Manager.

2.  From the File menu, select New Database.
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3.  In the File name field, type Test or the name to call
the database into which you will be importing.

Note the folder where this database is created in case
you want to delete it later.

4. Click New.

An empty database now appears in Reference
Manager.

5. From the References menu, select Import Text File.
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5. In the Database field, select the Test database or the
database you just created.

6. In the Filter field, click the browse button to locate the
filter you created or modified using Import Filter
Editor.

The File Select dialog appears.

7. Select the filter and click Select.

8. In the Text File field, click the browse button to select
the text file containing the references downloaded
from the database service.
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9. Locate the text file to import and click Open.

If you named the file with a different extension than
TXT, change the Files of type to All Files (*.*) so that
all files appear.

10.  In the Reference range field, make sure All is
selected.

11.  In the Additional keywords fields, make sure all the
fields are empty.

12.  Click the Options button.

The Options dialog box appears.

13.  Click the Reference Edit tab.
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14.  Click to clear the Check for Duplicate References,
Scan Titles, Notes, and Abstracts for Keywords
and Sort Keyword List check boxes.

Because you are testing to ensure that the import filter
imports the data correctly, turn off any settings that
could possibly alter the data.

Since you are modifying the Reference Manager
global settings for testing the import filter, reset it back
to the previous setting after the testing is complete.

15.  Click OK.

16.  Click Import.

If there are errors and the test was not successful, a
log file will tell you where issues occurred during the
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import. Review your references in the database and
make sure each field imported correctly. If not, then
go back and modify the filter using Import Filter Editor
to fix the problem.
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7
Printing Import Filter Information

You can use Import Filter Editor’s print function to print
information about the import filter as well as the selected
database.

This chapter includes:

♦ Printing Database Information

♦ Setting Up the Printer

♦ Print Previewing

Printing Database Information

When you print information in the Import Filter Editor, the
printout contains general information about the import
filter. It also prints information specific to the selected
database, such as tags, reference formats, and parsing
options.

Print is only available when you are in the Databases tab
in the Service window.
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To print the specifications of a database in an import
filter:

1.  In the Databases tab of the Service window, select the
database to print.

2.  From the File menu, select Print.

The standard Print dialog box for your printer appears.

3. Select your printing options and click OK.

Setting Up the Printer

You can change the printer or the printer setup also,
following instruction in this section.

To change the printer setup:

1.  From the File menu, select Print Setup.

The standard Print Setup dialog appears.

2.  Select the setup options and click OK.

Print Previewing

To view a file before you print it, use the Print Preview
function. This lets you view the pages that will print ahead
of time. From this screen you can also print the document
directly.
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To view a file on your screen:

1.  In the Databases tab of the Service window, select the
database.

2.  From the File menu, select Print Preview.

3.  Preview the file as desired and click Close.
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8
Troubleshooting

The following sections describe some of the more
common problems you might encounter, and their
solutions.

Hint: You can locate answers to Frequently Asked
Questions (FAQ) on our Web site at
http://www.risinc.com/.

Cannot locate the Destination Field name in the list
box.

The fields listed in the Destination Field list box are those
fields included in the Generic reference type. The field
name you are trying to locate is probably specific to a
certain reference type. See what field this maps to in the
Generic reference type and choose that as the destination
field.

Refer to the Appendix containing the Reference Type
Chart in your Reference Manager User’s Guide to see a
list of the reference types and the fields to which they
map. You can customize this using Field and Type Edit,
found in the Tools menu in Reference Manager.
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The tagged field is importing into the wrong
Reference Manager field.

The fields listed in the Destination Field list box are those
fields included in the Generic reference type. The field you
are trying to import is probably specific to a certain
reference type. You can customize this using Field and
Type Edit, found in the Tools menu in Reference
Manager.

Refer to the Appendix containing the Reference Type
Chart for a list of the reference types and the fields to
which they map.

No keywords or notes are imported.

In the Field and Type Editor dialog box (from within
Reference Manager), ensure that you have specified to
include the keywords and notes field for the reference
type. The boxes (under the column labeled I for Include)
should be checked.

In Import Filter Editor, you can make sure these tagged
fields are specified in the reference type specific tags or
common tags and that their Destination fields are set
correctly. If they are already specified and you are using
common tags, make sure they are included for this
database’s reference type specific tags.

One or more of the tagged fields is not importing.

See the solution directly above for keywords or notes not
importing.

Check the format of the tag(s) that is not importing to see
if it follows the tag format specified in Import Filter Editor.
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No references are imported.

Verify that you have defined the Reference Format. If the
Reference Format is defined, check to see if it exists in
the text file. Make sure the tag format matches the file.

Make sure the tags in the text file follow the tag format
specified.

Make sure tags are defined for the reference types you are
importing.

All author names or keywords are importing as one
name or one keyword.

Ensure that you have specified Keywords/Authors
separated by a delimiter. This usually occurs if multiple
author names or keywords are listed in a single field.

The Source fields in my text file are not in a
consistent format.

Try to make the formats consistent using Replace Text. As
a last option, you can also use your word processor to edit
the text file to make the Source fields consistent.
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